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Introduction to the Cisco Unified 
Communications Express 
Historical Reporting Client

The Cisco Unified Communications Express Historical Reporting Client (also referred to as 
Cisco UCE Historical Reporting Client) is a software system that provides information about past call 
activities of a Cisco Unified Communications Express (Cisco UCE) system. The Cisco UCE Historical 
Reporting Client (HRC) runs in a separate window application that is used to view reports from a single 
Cisco Unity Express application. 

Data about past call activities is stored in a database as the Cisco Unified Communications Express 
system runs. This data is used as a basis for the reports. 

To run Cisco Unified Communications Express Historical Reporting Client software:

• You must be logged into the Cisco Unity Express Administration web interface.

• You must have historical reporting (HR) privileges.

Note An Interactive Voice Response (IVR) license is not required to run the 
Cisco Unified Communications Express Historical Reporting Client. 

Use the Cisco Unified Communications Express Historical Reporting Client to do the following:

• View, print, and save reports.

• Sort and filter reports.

• Schedule reports and send them to a file or printer.

• Export reports in a variety of formats, including Portable Document Format (PDF), 
Microsoft Excel (XLS), Rich Text Format (RTF), Extensible Markup Language (XML), and 
Comma-Separated Values (CSV).

• Prepare custom reports using a variety of generally available third-party applications that are 
designed to create reports from a database.

When you first start Cisco Unified Communications Express Historical Reporting Client, you will see 
the Main Window. For more information, go to the following chapters contained in this guide:

• Installation and Configuration, page 2-1

• Main Window, page 3-1

• Report Descriptions, page 4-1
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• Generating Historical Reports, page 5-1

• Scheduling Historical Reports, page 6-1
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Installation and Configuration

The following topics describe how to install and configure the Cisco Unified Communications Express 
Historical Reporting Client (Cisco UCE).

• Installing Cisco UCE Historical Reports, page 2-1

• Setting User Permissions to Cisco UCE Historical Reports, page 2-3

• Configuring Cisco UCE Historical Reporting Client, page 2-4

Installing Cisco UCE Historical Reports
The following sections explain how to install, reinstall, upgrade, or uninstall the Cisco UCE 
Historical Reporting Client. 

• Prerequisites, page 2-1

• Install and Upgrade, page 2-2

Prerequisites
Ensure that you can access the Cisco UCE server. Do not install the 
Cisco UCE Historical Reporting Client on the Cisco UCE server. You can install the client software on 
as many client computers as you like. The client computer must run either of the following operating 
systems:

• Microsoft Windows 2000 Professional (Service Pack 4 or higher)

• Microsoft Windows XP Professional

The client computer must also have the following software installed:

• Microsoft Internet Explorer 5.5 or higher version.

• Microsoft Data Access Component (MDAC) version 2.7 or higher

Before installing or upgrading the software, perform the following steps. These steps show how to exit 
the Cisco UCE Historical Reporting Client and the Cisco UCE Historical Reporting Client Scheduler.

Step 1 From the Cisco UCE Historical Reporting Client main window, choose File > Exit. 

From the main window of Cisco UCE Historical Reporting Client, right-click the Scheduler icon and 
choose Exit.
2-1
ess Historical Reporting Client Configuration Guide



 

Chapter 2      Installation and Configuration
  Installing Cisco UCE Historical Reports
The Scheduler unloads and will not execute schedules.

If the Cisco UCE Historical Reporting Client or Cisco UCE Historical Reporting Client Scheduler are 
running, the following message is displayed in the Cisco UCE Historical Reporting Client Setup dialog 
box: “Please ensure that the CUCE Historical Reporting Client and 
CUCE Historical Reporting Client Scheduler are stopped before proceeding.”

Step 2 Click OK.

Install and Upgrade
To install or reinstall, upgrade, or uninstall Cisco UCE Historical Reporting Client, perform the 
following steps:

Step 1 Download the installer from the Cisco Unity Express software download pages on www.cisco.com by 
going to the following link:

http://www.cisco.com/kobayashi/sw-center/sw-voice.shtml

Find the file, CUCEHistoricalReportsInstall-X.Y.Z.exe where X.Y.Z is the release version. For example, 
CUCEHistoricalReportsInstall-3.0.1.exe.

Step 2 On the client computer, use Microsoft Windows Explorer (or similar file browsing software), to navigate 
to the installer executable file. Double-click the installer file to execute the installer.

The message “Preparing Setup. Please wait while the InstallShield Wizard prepares the setup” appears.

• If you already have a version of Cisco UCE Historical Reports installed, the message “A previous 
version <version number> of Cisco Historical Reporting Client is detected on your system. Please 
select the task to perform:” appears in the Cisco Historical Reporting Client Setup dialog box.

– reinstall/upgrade or uninstall, go to Step 3.

• If you are installing Cisco UCE Historical Reports for the first time on this computer, and there is 
not an existing version of the software on the computer, the message “Welcome to the InstallShield 
Wizard for Cisco Historical Reporting Client” message appears in the 
Cisco Historical Reporting Client Setup dialog box.

– install, go to Step 4.

Step 3 If you are doing a reinstall, upgrade, or uninstall, do one of these two actions:

a. To upgrade or reinstall the Cisco UCE Historical Reporting Client, click Upgrade/Reinstall 
Version.

The message “Cisco Historical Reporting Client is configuring your new software” appears. 

(The remaining steps for upgrade/reinstall are the same as for the final install steps.)

– Click Next.

The message “Would you like to create a shortcut for Cisco UCE Historical Reports on your 
desktop?” appears in the Desktop Shortcut dialog box.

– Click Yes to create a shortcut for Cisco UCE Historical Reporting Client on your Windows 
desktop.

The message “InstallShield Wizard Complete” appears.

– Click Finish.
2-2
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The upgrade/reinstall is complete.

b. To uninstall the Cisco UCE Historical Reporting Client, choose Uninstall Version and click Next.

The “Confirm Uninstall” dialog box appears.

– Click OK. 

After a pause, the message “Maintenance Complete” appears.

– Click Finish.

The uninstall is complete.

Step 4 If you are installing In the Cisco Historical Reporting Client Setup dialog box, click Next.

The message “Cisco Historical Reporting Client is configuring your new software installation” message 
appears.

The message “Please select the drive where you would like to install CUCE Historical Reporting Client” 
appears.

Step 5 Choose a drive and click Next.

The License Agreement appears.

Step 6 After reading the license agreement, click Yes.

The message “Please enter the CUCE hostname or IP address” appears.

Step 7 Enter the hostname or IP address of the Cisco Unified Communications Express host, and click Next.

If you do not enter this information now, you can enter it later when you start the Cisco UCE 
Historical Reporting Client. The IP address/hostname is the address of the Cisco Unity Express module.

The message “Start Copying Files. Review settings before copying files” appears.

Step 8 Click Next.

The message “Would you like to create a shortcut for CUCE Historical Reports on your desktop?” 
appears in the Desktop Shortcut dialog box.

Step 9 Click Yes to create a shortcut for Cisco UCE Historical Reporting Client on your Windows desktop.

The message “InstallShield Wizard Complete” appears in the Cisco UCE Historical Reporting Client 
Setup dialog box.

Step 10 Click Finish.

The install is complete. The computer restarts, if necessary.

Setting User Permissions to Cisco UCE Historical Reports
This section explains how to set user permissions to access the following reports. These topics are 
explained in the “Report Descriptions” section on page 4-1. 

• Abandoned Call Detail Activity Report, page 4-1

• Application Performance Analysis Report, page 4-3

• Call Custom Variables Report, page 4-2

• Called Number Summary Activity Report, page 4-3

• Traffic Analysis Report, page 4-5
2-3
Cisco Unified Communications Express Historical Reporting Client Configuration Guide

OL-14986-01



 

Chapter 2      Installation and Configuration
  Configuring Cisco UCE Historical Reporting Client
To set up the user to have “ViewHistoricalReports” privilege, perform the following steps.

Step 1 Access the Cisco Unified Communications Express Administration software and set up the user.

(If the user is a member of the “Administrator” group they will automatically have 
“ViewHistoricalReports” privilege.)

Step 2 Set privilege “ViewHistoricalReports” for the user.

Configuring Cisco UCE Historical Reporting Client
To begin configuring Historical reporting, go to Administration > Historical Reporting.

Configuring Cisco UCE Historical Reporting Client is explained in the following sections:

• Prerequisites, page 2-1

• Editing a Configuration File, page 2-4

• Configuration File hrcConfig.ini, page 2-5

• Configuration File SCH.ini, page 2-6

To edit configuration files for Cisco UCE Historical Reporting Client, perform the steps as explained in 
the “Prerequisites” section on page 2-1 and the “Editing a Configuration File” section on page 2-4.

Two configuration files are maintained on each client computer:

• Configuration File hrcConfig.ini: contains general instructions and is stored in the ~CUCE 
Historical Reports directory. For example, the directory c:\Program Files\Cisco Systems\CUCE 
Historical Reports.

• Configuration File SCH.ini: contains instructions on how to run the Scheduler and is stored in the 
~CUCE Historical Reports\Scheduler directory. For example, the directory c:\Program Files\Cisco 
Systems\CUCE Historical Reports\Scheduler. See also Chapter 6, “Scheduling Historical Reports.”

Prerequisites
If you plan to edit the hrcConfig.ini file, and the Cisco UCE Historical Reporting Client software is 
running, first exit the software by choosing File > Exit in the main window.

If you plan to edit the SCH.ini file, and the Cisco UCE Historical Reporting Client Scheduler is running, 
first exit the Scheduler by right-clicking the Scheduler icon that appears in the status area on your 
Windows task bar and choosing Exit. See also Chapter 6, “Scheduling Historical Reports.”

Editing a Configuration File
Configuration files hrcConfig.ini and SCH.ini are described in the “Configuration File hrcConfig.ini” 
section on page 2-5 and the “Configuration File SCH.ini” section on page 2-6. To edit a configuration 
file, follow these steps:

Step 1 Use any text editor (for example, Notepad) to open the configuration file.
2-4
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Note If you edit the configuration files and make changes that are not recognized by the system, the 
system may be corrupted.

Step 2 Make changes to parameters as desired. For example, you can change “NumOfLogFiles = 10” to 
“NumOfLogFiles = 11.” Commented lines in the configuration files start with a semi-colon ( ; ).

The parameters you can change are shown in the following sections:

• Configuration File hrcConfig.ini, page 2-5

• Configuration File SCH.ini, page 2-6

Step 3 Save the configuration file when you finish with your changes and exit the Editor.

Step 4 If you are editing the hrcConfig.ini file, start the Cisco UCE Historical Reporting Client or right-click 
the Scheduler icon in the status area of the Windows taskbar and choose Start Scheduler. Your changes 
now take effect.

Configuration File hrcConfig.ini
The hrcConfig.ini file contains general instructions for the Cisco UCE Historical Reporting Client 
system. Table 2-1 shows the parameters in this .ini file.

Table 2-1 hrcConfig.ini file: Parameters

Parameter Description and Default Value

defaultHost IP address or hostname that appears in the Server field in the Cisco UCE 
Historical Reporting Client Login dialog box.

• IP address or hostname of the server that most recently logged into server. This is the 
default IP address/hostname.

defaultExportPath File path name of the folder to hold scheduled reports to be exported to a file.

• Installation directory for Cisco UCE Historical Reports.

showUserNameOnReport Show the username of the user who is logged in when a report is generated.

• 0: Name does not appear.

• 1: Name appears. (Default: 1.)

logLevel Level of detail for recording events in the log file.

• 1: Record errors only. (Default: 1.)

• 2: Record errors and warnings.

• 3: Record errors, warnings, and debugging messages.

NumOfLogFiles Number of log files being maintained by the system. A new file is created whenever the 
current file reaches the size specified by MaxSizeOfLogFiles. (See the next parameter, 
MaxSizeOfLogFiles.)

• 1 (Integer) or greater. (Default: 10.)
2-5
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Configuration File SCH.ini 
The SCH.ini file contains general instructions for the Scheduler, including the location of the Scheduler 
database, the level of detail in which to record log file information, and how to handle missed schedules. 
If a schedule was missed, when the Scheduler starts a dialog box asks whether you want to execute 
missed schedules. Table 2-2 shows the parameters in the SCH.ini file.

MaxSizeOfLogFiles Maximum size of the log file. When the current log file reaches this size in KB, a new log 
file is created by the Cisco UCE Historical Reporting Client.

• 1 (Integer) or greater. (Default: 1000.)

Note We recommend the 1000 KB value for this parameter because a log file that is 
larger than 1000 KB can be difficult to read, and several large log files may occupy 
a significant amount of disk space.

database (under [SCH]) Database file holding scheduling information in the directory: c:\Program Files\Cisco 
Systems\CUCE Historical Reports\Scheduler.

Note If you change this parameter, you must also change the database parameter in the 
SCH.ini configuration file to the same value. See the “Configuration File SCH.ini” 
section on page 2-6.

• HistoricalReportsScheduler.mdb.

Provider (under [SCH]) Display only. Name of the provider.

SERVER (under 
[CUE_DATABASE])

Display only. IP address or hostname of the server containing historical data for the 
Cisco UCE Historical Reporting Client.

DATABASE (under 
[CUE_DATABASE])

Display only. Main historical database on the Cisco UCE server used by the 
Cisco UCE Historical Reporting Client.

UID (under 
[CUE_DATABASE])

Display only. User identification used to log in to the Cisco UCE database on the 
Cisco UCE server.

NETWORK (under[SCH]) Display only. Network library used by the Cisco UCE Historical Reporting Client when 
connecting to the Cisco UCE scheduler.

MAXCONNECTIONS (under 
[CUE_DATABASE]) 

Maximum number of connections.

NODE_ID (under 
[CUE_DATABASE])

Cisco UCE node ID.

Table 2-1 hrcConfig.ini file: Parameters (continued)

Parameter (continued) Description and Default Value (continued)
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Related Topics

• Scheduling Historical Reports, page 6-1

Where to Go Next
See Chapter 3, “Main Window.”

Table 2-2 SCH.ini File: Parameters

Parameter Explanation

database Database containing schedule information in the following directory: 
Cisco Unified Communications Express Historical Reports \Scheduler. If you change this 
parameter, you must also change the database parameter in the hrcConfig.ini 
configuration file to the same value. 

• HistoricalReportsScheduler.mdb

NumOfMissedScheduleRuns When one or more scheduled reports are missed because the Scheduler is not running, 
specifies up to how many of the missed reports will be generated. These missed reports 
will only be generated if one of the parameters such as Missed_daily, Missed_weekly, 
Missed_monthly are set to 1. 

• 0 (zero) or greater. (Default: 1.)

Missed_daily For reports that are scheduled to run daily, specifies whether the reports should be 
generated if they are missed and you choose to execute missed schedules.

• 1: Generate the report. (Default: 1.)

• 0: Do not generate the report.

Missed_weekly For reports that are scheduled to run weekly, specifies whether the reports are generated if 
they are missed and you choose to execute missed schedules.

• 1: Generate the report. (Default: 1.)

• 0: Do not generate the report

Missed_monthly For reports that are scheduled to run monthly, specifies whether the reports are generated 
if they are missed and you choose to execute missed schedules.

• 1: Generate the report. (Default: 1.)

• 0: Do not generate the report.

Missed_once For reports that are scheduled to run once, specifies whether the reports should be 
generated if they are missed and you choose to execute missed schedules.

• 1: Generate the report. (Default: 1.)

• 0: Do not generate the report.

logLevel Level of detail in which the system records events in the Scheduler log files.

• 1: Record Scheduler errors only.

• 2: Record Scheduler errors and Scheduler warnings.

• 3: Record Scheduler errors, Scheduler warnings, and schedule information. (Default: 
3.)

• 4: Record Scheduler errors, Scheduler warnings, and detailed schedule information
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Main Window

The Main Window of the Cisco Unified Communications Express (Cisco UCE) 
Historical Reports Client consists of the following options:

• Menu Bar, page 3-2

• Toolbar, page 3-3

• Reporting Task Pane, page 3-4

• General and Detailed Tabs, page 3-4

• Schedule, View, Reset, Help Buttons, page 3-5

Each of these options are explained in Table 3-1.

Table 3-1 Main Window Options: Descriptions

Option Description

Menu Bar Options for File, View, Settings, and Help.

Toolbar Quickly access menu options for opening a file, saving a file, changing login 
username and password, and viewing the scheduled log files.

Reporting Task 
Pane

Radio buttons for generating, viewing, scheduling, and loading a report.

General and 
Detailed Tabs

Options for specifying the type, sorting, and filtering of a report.

Schedule, 
View, Reset, 
Help Buttons

View Button (The View Button is only visible if the Generate option is selected in 
the Reporting Task Pane). Clicking the View button generates a report and allows 
you to view the report.

Schedule Button (The Schedule button is only visible if Schedule future reports is 
selected in the Reporting Task Pane). Clicking the Schedule button schedules a 
report and shows the historical data within a date range.

Reset Button: Resets the settings to the original report settings.

Help Button: Shows online help information.
3-1
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Menu Bar
The Menu Bar, which is situated at the top of the main window, consists of options including: File, Edit, 
Tools, Debug.

The following sections show the menu bar options in the main window of Cisco UCE Historical Reports:

• File Menu, page 3-2

• View Menu, page 3-2

• Settings Menu, page 3-3

• Help Menu, page 3-3

File Menu
The File Menu allows you to open, or save current report settings files. Table 3-2 lists the options that 
you can use in the File Menu.

View Menu
The View Menu allows you to toggle on/off two areas of the main window: the Toolbar and the Status 
Bar. The Toolbar is situated towards the top of the main window, below the Menu Bar. The Status Bar is 
situated at the lowest part of the main window. Table 3-3 lists the options that you can use in the View 
Menu.

Table 3-2 File Menu: Descriptions

Option Description

Open Display a list of report settings files.

Save Save current report settings file.

Save As Open a Save window to save the current report settings file by entering a filename 
with a .chc extension.

Exit Exit the Cisco UCU Historical Reports client.

Table 3-3 View Menu: Descriptions

Option Description

Toolbar Display tools in the Toolbar to use as alternatives to the equivalent options in the 
Menu Bar.

Status bar Display current date and time.
3-2
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Settings Menu
The Settings Menu allows you to log in as a different user to a different server, or to access the Reports 
Scheduler. Use the Reports Scheduler to add, change, or delete schedules. Table 3-4 lists the options that 
you can use from the Settings Menu.

Help Menu
Table 3-5 lists the options that you can use in the Help Menu.

Toolbar
An alternative method for choosing the main options in the drop-down list is to use the toolbar.

The toolbar, which contains a series of icons, is situated toward the top of the main window, below the 
Menu Bar.

When you position the cursor over an active tool, a tooltip appears. For example, if you hover the cursor 
over the first toolbar icon, “Open” is displayed.

Information about each of the different tools is in Table 3-6.

Table 3-4 Settings Menu: Descriptions

Option Description

Login Log in as a different user or log in to a different server. See Settings > 
Login in the Menu Bar.

Scheduler List schedules stored in the Reports Scheduler. See the “Viewing and 
Deleting Schedules” section on page 6-9.

Table 3-5 Help Menu: Descriptions

Option Description

Contents Open the first page of the online help system in a browser window.

Search For Help On Open the search page of the online help system in a browser window.

Application Logs List the .log files in the logs directory. The logs directory is located 
underneath the directory in which you installed the Cisco UCE Historical 
Reports system. The default system directory is in the ~Program Files 
directory.

About Display the version number of Cisco UCE Historical Reports client 
software, User Name of current session, Apps Server, Database Server. 

Table 3-6 Basic Toolbar: Descriptions

Option Description

Open Display a list of report settings files. Equivalent to File > Open in the Menu Bar.

Save Save current report settings file. Equivalent to File > Save in the Menu Bar.
3-3
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Reporting Task Pane
This is the first area at the top of the Main Menu, below the toolbar and Menu Bar. Table 3-7 lists the 
options that are available in the Reporting Task Pane.

General and Detailed Tabs
The main options of Options of Cisco Unified Communications Express Historical Reports are in the 
General and Detailed tabs of the main window. Table 3-8 and Table 3-9 list the general and detailed 
options that are available.

Login Log in as a different user or log in to a different server. See Settings > Login in the 
Menu Bar.

Scheduler List schedules stored in the Reports Scheduler. See the “Viewing and Deleting 
Schedules” section on page 6-9. Equivalent to Settings > Scheduler in the Menu 
Bar.

Help Access the online help system.

Table 3-6 Basic Toolbar: Descriptions (continued)

Option Description

Table 3-7 Reporting Task Pane: Descriptions

Option Description

Generate and view historical reports Specify settings including the report type, date and time 
range. See Chapter 5, “Generating Historical Reports.”

Schedule future reports, including 
repeat reports

Specify settings including the report type, schedule, and 
export file type. See Chapter 6, “Scheduling Historical 
Reports.”

Load existing report setting Specify settings saved from the last time you generated or 
viewed a report. See the “Loading Report Settings” 
section on page 5-5.

Table 3-8 General Tab: Descriptions

Option Description

Report Type Specify the type of report to view/generate, which is one of a range of 
available reports. See Chapter 4, “Report Descriptions.”

Include charts in report Check the box to include the optional charts along with the main report. 
See each report described in Chapter 4, “Report Descriptions.”

Time Range Specify the time range by defining the period between the Report Start 
Date and the Report End Date.

Reminder A warning message. For example, generating reports at an off-peak 
time minimizes impact on the server.
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Schedule, View, Reset, Help Buttons
The three buttons in the lower half of the main window are either Schedule|Reset|Help or 
View|Reset|Help. See Table 3-10 for more information.

The Schedule button is visible if the “Generate and view historical reports” option is selected in the 
Reporting Task Pane. Clicking the Schedule button gives you access to the Scheduler.

Where to Go Next
See Chapter 4, “Report Descriptions.”

Table 3-9 Detailed Tab: Descriptions

Option Description

Sort Report By Specify settings including the report type, date, and time range. See 
the “General Report Settings” section on page 5-1.

Filter Parameter Specify settings including the report type, schedule, and export file 
type. See Chapter 6, “Scheduling Historical Reports.”

Parameter Setting area Available panel contains parameter settings based on the filter 
parameter.

Selected panel holds the settings chosen from the Available panel. 

See the “Specifying a Filter Parameter” section on page 5-3.

Table 3-10 Schedule, View, Reset, Help Button: Descriptions

Option Description

Schedule Schedule button: Schedule a report and show the historical data within a specified 
date range.

Note The Schedule button is only visible if the “Generate and view historical 
reports” option is selected in the “Reporting Task Pane” section on page 3-4.

View View button: Generate and view a report.

Note The View button is only visible if “Schedule future reports...” is selected in 
the “Reporting Task Pane” section on page 3-4.

Reset Reset the settings to the original report settings.

Help Show online help.
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Report Descriptions

Table 4-1 lists the reports that can be created by the Cisco UCE Historical Reporting Client. 

Abandoned Call Detail Activity Report
The Abandoned Call Detail Activity Report provides information about calls that are abandoned. A call 
is abandoned if it does not get past the workflow Set Contact Info step that sets the handled flag. The 
Abandoned Call Detail Activity Report can include the following chart:

• Calls Abandoned Each Day—For each day in the date range, displays the total number of calls 
abandoned.

Table 4-2 lists the statistics that are produced in the Abandoned Call Detail Activity Report for each 
abandoned call.

Table 4-1 Report Description: Fields

Report Description

Abandoned Call Detail 
Activity Report

Detailed information about each abandoned call during 
the specified report period.

Application Performance 
Analysis Report

Summary information about calls received by each 
application.

Traffic Analysis Report Calls received by each Cisco UCE system for each day in 
the report range.

Called Number Summary 
Activity Report

Numbers dialed by callers.

Call Custom Variables Report Information about any custom variables.

Table 4-2 Abandoned Call Detail Activity Report: Fields

Field Description Sort Capability

Call Start Time Date and time that this call started. Y—Displays the report in order of 
the date and time that the call started.

Called Number Telephone number that the caller 
dialed.

N
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Call Custom Variables Report
The Call Custom Variables Report shows information about any custom variables that are set by the
Set Session Info step in the workflow that the application has associated with an active call. The Call 
Custom Variables Report can be used to get peg-counts related statistics for IVR/AA applications. For 
example, if the customer wants to peg count the number of users who select “Dial by Extension” and 
“Dial by Name” in the autoattendant application, they can use this report to gather such statistics.

The Call Custom Variables Report can be sorted by the following criteria:

• Call Start Time—Displays the report in order of call start times.

The Call Custom Variables Report can be filtered by any of the parameters found in Table 4-3.

Set Session Info 
The Set Session Info step stores custom data for use in the Call Custom Variables Report. See the 
Cisco Unity Express Guide to Writing and Editing Scripts for more information about Set Session Info.

Call ANI

(automatic number 
identification)

Telephone number of the originator of 
the caller.

Y—Displays the report in order of 
the telephone number that the caller 
is calling from.

Call Abandon Time Date and time that the call was 
abandoned.

Y—Displays the report in order of 
the date and time that the call was 
abandoned.

Table 4-2 Abandoned Call Detail Activity Report: Fields (continued)

Field Description Sort Capability

Table 4-3 Call Custom Variables Report Filter: Fields

Filter Parameter Result

Original Called Number Information about the specified original called number or 
numbers. 

Called Number Information about the specified called number or numbers.

Calling Number Information about the specified calling number or numbers.

Application Name Information about the specified application or applications.

Contact Type Information about the specified contact type or types (incoming, 
outgoing, internal).

Duration Greater Than or Equal 
to T seconds

Calls with duration greater than or equal to the number of seconds 
specified by T.

Duration Less Than or Equal to 
T seconds

Calls with duration less than or equal to the number of seconds 
specified by T.

Custom Variables “_ccdrVar1” 
through “_ccdrVar10,” Any 
Custom Variable

Calls with specified variables. Enter a whole string or a substring 
for which to search. Separate multiple strings with commas. 
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Called Number Summary Activity Report
The Called Number Summary Activity Report shows information about each number dialed by an inside 
or outside caller. This report includes information for calls to IVR applications.

The Called Number Summary Activity Report can include these charts:

• Total Calls by Called Number—Displays the total number of calls to each number.

• Average Call Duration by Called Number—Displays the average time that each call lasted for each 
number dialed.

Table 4-4 lists the information found in the Called Number Summary Activity Report for each number 
called.

Application Performance Analysis Report
The Application Performance Analysis Report shows information about calls received by each 
application and can include the charts listed in Table 4-5.

Table 4-4 Called Number Summary Activity Report: Fields

Field Description Sort Capability

Called Number The route point number associated with the 
application. 

Y—Displays the report in order of the number called. 
This number is the route point number.

Total Calls Total number of calls to each number. Y—Displays the report in order of the total number of 
calls that were originally dialed to each number.

Avg Calls Average number of calls per day. N

Avg Call Duration Average duration of calls to each number. Y—Displays the report in order of the average duration 
of calls to each number.

Table 4-5 Application Performance Analysis Report: Descriptions

Chart Name Description

Total Incoming Calls by Application Displays the total number of calls that each application 
received.

Calls Handled vs. Calls Abandoned by 
Application

Displays the total number of calls handled by each 
application and total number of calls abandoned while in 
each application.

Average Call Duration by Application Displays the average length of calls that each application 
received.
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Table 4-6 lists the information found in the Application Performance Analysis Reports fields for each 
application.

Table 4-6 Application Performance Analysis Reports: Fields

Field Description Sort Capability

Application ID Identification number that the system assigned to the 
application.

Y—Displays the report in order of the 
identification number that the system 
assigned to each application.

Application Name Name of the application. N

Total Incoming Calls Number of calls received by the application. This 
number is equal to the number of calls handled by the 
application plus the number of calls abandoned while 
in the application.

Y—Displays the report in order of the 
number of calls that were received by 
each application

Calls Handled Number of calls handled by the application. A call is 
handled when it reaches the workflow step that defines 
the call as handled.

N

Calls Abandoned Number of calls abandoned while in the application. A 
call is abandoned if it does not reach the workflow step 
that defines the call as handled.

N

Abandon Rate Average number of calls that were abandoned in each 
hour while in the application.

Y—Displays the report in order of 
average number of calls abandoned per 
hour while in each application.

Avg Call Duration Average time that elapsed from the time that the call 
entered this workflow until the call exited this 
workflow by hanging up or entering another workflow.

N
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Traffic Analysis Report
The Traffic Analysis Report shows information about incoming calls to the system and can include the 
charts listed in Table 4-7.

Table 4-8 lists the information that can be found in the Traffic Analysis Report for each date in the report 
range.

Where to Go Next
See Chapter 5, “Generating Historical Reports.”

Table 4-7 Traffic Analysis Reports: Descriptions

Chart Name Description

Total Incoming Calls by Date Displays the total number of calls received by the system for each 
day in the report range.

Peak Calls by Date For each date, displays the number of calls received in the hour 
with the most calls.

Average Call Duration by Date Displays the average length of calls for each day in the report 
range.

Table 4-8 Traffic Analysis Reports: Field

Field Description Sort Capability

Date Date for which information is provided. Y—Displays the report in 
order of the date for which 
information is provided.

Total Incoming Calls Total number of calls received by the system. N

Avg Calls Average number of calls received during each hour. N

Peak Calls Number of calls received during the peak hour. (See the next 
field.)

N

Peak Hour Start,
Peak Hour End

Start and end time of the hour during which the largest number 
of calls were received. This hour is defined as the peak hour.

N

Avg Call Duration Average call length. N

Min Call Duration Length of shortest call. N

Max Call Duration Length of longest call. N
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Generating Historical Reports

To generate a report using the Cisco Unified Communications Express (Cisco UCE) Historical 
Reporting Client, follow these steps:

1. Choose General Report Settings, including the name of the report, whether to include charts, and 
the date and time range for which you want information.

2. Choose Detailed Report Settings, including a sort method and a filter parameter.

3. Use the Report Viewer to view, print, or save (export) the report.

Generating reports with the Cisco UCE Historical Reporting Client is explained in the following 
sections:

• General Report Settings, page 5-1

• Detailed Report Settings, page 5-2

• Saving and Loading Report Settings, page 5-4

• Report Viewer, page 5-6

General Report Settings
The general report settings are shown in the General Tab of the main window, beneath the text that reads, 
“Select the options for historical reports below.” Table 5-1 lists the available general report settings.

You can return report settings to their default values at any time by clicking Reset in the Cisco UCE 
Historical Reports main window. This action resets both general report settings and detailed report 
settings.

To choose the report that you want to generate, follow these steps:

Table 5-1 General Report Settings: Descriptions

Setting Description

Report Type Name of the report to generate. 

Include charts in 
report 

Radio button to indicate that charts are included with the report. Each 
historical report contains one or more charts that display specific 
information in the report.

Time Range Start/End date and time that specifies a period to use for the data in this 
report. 
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Step 1 In the Reporting Task area of the main window, choose the Generate and View Historical Reporting 
Client radio button.

The window displays tabs for general and detailed report settings.

Step 2 Click the General tab.

The General Report Settings area appears.

Step 3 From the Report Type drop-down list, choose a report.

If you have already generated this report in this Cisco UCE Historical Reporting Client session, any 
information that you previously entered in the general or detailed fields for this report appears in these 
fields again.

Now you can choose additional general report settings and choose detailed report settings. You also must 
specify a date and time range for the report before you can view it.

Detailed Report Settings
Optionally choose detailed report settings to present information in a particular order and to include only 
specific information.

The settings include:

• Sorting method: Order in which information appears in a report. For further information see the 
“Specifying a Sorting Method” section on page 5-2.

• Filter parameter: To limit the information in a report. For further information see the “Specifying a 
Filter Parameter” section on page 5-3.

To return report settings to their default values, click Reset in the main window. If a Report Settings file 
is loaded, clicking Reset returns both report settings to values specified in the file.

Note Automated maintenance periodically purges old records from the database to make room for new 
records. See the Cisco Unity Express 3.0 GUI Administrator Guide for more information on setting purge 
options.

Specifying a Sorting Method
Use a sorting method to order the information in a report. To specify a sorting method for the report:

Step 1 In the Reporting Task area of the main window of Cisco UCE Historical Reporting Client, click 
Generate and View Historical Reports.

The window displays tabs for general and detailed report settings.

Step 2 Click the Detailed tab.

The Detailed Report Settings area appears.

Step 3 From the Sort Report By drop-down list, choose the sort method that you want to use.
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Specifying a Filter Parameter
Use a filter parameter to reduce the amount of information presented in a report. 

For example, if you are generating a Custom Variables Report, you can use a filter parameter to include 
information for specific agents only.

Note Some reports do not have a filter parameter available: the Parameter Setting area displays “No Parameter 
Detailed Settings Available.”

To specify a filter parameter:

Step 1 In the Reporting Task area of the main window, click the Generate and View Historical Reports radio 
button.

The window displays tabs for general and detailed report settings.

Step 2 Click the Detailed tab.

The Detailed Report Settings area appears.

Step 3 From the Filter Parameter drop-down list, choose the filter parameter.

Depending on the filter parameter you choose, the Available pane of the Parameter Setting area displays 
either a list of available parameter settings or the Enter Parameter Value field. If you previously chose 
parameter settings for this report and this parameter during this session, the previous settings are 
displayed in the Selected pane.

You can also customize the detail call records using the Custom Variables included in the detailed filter 
parameter drop-down list. These variables can be assigned to keep track of things like language, numbers 
on the keypad that are being pressed, and options that are chosen while navigating the IVR or auto 
attendant (AA) application. These custom variables are used by the Set Session Info step and are viewed 
in the Call Custom Variables Report. This data is preserved as part of backup and restore and can also 
be exported in comma-separated (CSV) format as described in the copy hrdb command, for use in other 
databases or spreadsheets. See the Cisco Unity Express 3.0 Command Reference for more information.

If you choose a predefined parameter setting, go to Step 4.

If you choose to customize a parameter setting using one of the Custom Variables, go to Step 5.

Step 4 From the list of available parameter settings, choose the parameter setting or settings that you want to 
use:

• To choose a settings from the Available pane, choose the setting and then click >. The setting moves 
to the Selected pane. To select all of the settings, click >> without choosing any settings.

• To unselect settings from the Selected pane, choose the setting, and then click <. To unselect all of 
the settings, click << without choosing any settings.

Step 5 In the Enter Parameter Value field, enter the value that you want to use as n in the filter parameter. Use 
a comma to separate multiple values.
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Saving and Loading Report Settings
If you generate specific reports frequently, you may find that it is convenient to save the general and 
detailed report settings that you choose for these reports. You can recall these settings and make 
adjustments to them each time that you generate the report.

Save report settings in a Report Settings file. When you load a Report Settings file, the report settings 
saved in that file appear in the main window of Cisco UCE Historical Reporting Client.

• Saving Report Settings, page 5-4

• Loading Report Settings, page 5-5

• Changing and Saving Report Settings, page 5-5

Saving Report Settings
By default, the Cisco UCE Historical Reporting Client saves Report Settings files on your computer in 
the ~CUCE Historical Reports\Reports directory, which is under the directory in which you installed the 
Cisco UCE Historical Reporting Client system. (The default installation directory is ~Program Files). 
The Report Settings file defaults to the name reportname.chc. You can change the default name and the 
directory. However, the Report Settings file must have a .chc extension. 

To exit the Report Viewer window, click the Close button on the title bar.

To save report settings in a new Report Settings file, perform the following steps.

Step 1 In the main window, choose the general report settings and detailed report settings that you want to save.

Step 2 Choose File > Save, or choose File > Save As, or click the Save tool.

The Save As dialog box appears. 

Step 3 In the Save As dialog box, to save Report Settings files in a directory other than the default directory, 
perform one of the following actions:

• From the Save In drop-down list, select a directory.

• In the Folder Name pane, enter a directory/folder name.

• Save In tools.

Step 4 In the Save As dialog box, to change the filename that appears in the File Name field, perform one of 
the following actions:

• Enter a new filename.

• Choose a file that already exists by clicking the File Name drop-down arrow.

A message appears asking if you want to replace the existing file.

– Click Yes.

Note A report settings filename must have a .chc extension. The system adds this extension to the 
name in the File Name field automatically.

Step 5 Click Save.
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The Cisco UCE Historical Reporting Client saves the Report Settings file.

Loading Report Settings
To reuse previously saved report settings, click Load Existing Report Settings in the Reporting Tasks 
area of the main window.

To load report settings from the main window:

Note You cannot load report settings from a file containing settings for a report for which you do not have 
access. You cannot load report settings from a file created using a different from the current language.

Step 1 Do one of the following actions:

• In the Reporting Task area of the main window, click Load Existing Report Settings.

• Click the Open tool or choose File > Open.

The Open dialog box appears, showing the File List pane.

Note If the Report Settings file that you want does not appear in the list, use the Look In drop-down 
arrow, the Folder Name pane, or the Save In tools to specify the directory. Then double-click the 
name of the file, or click the name of the file and then click Open.

Step 2 From the File List pane, choose the name of the file to be loaded.

Step 3 Do one of the following actions:

• Double-click the file.

• Click the name of the file and then click Open.

The Cisco UCE Historical Reports main window appears. 

The fields in the General and Detailed tabs contain settings from the Report Settings file.

Changing and Saving Report Settings
To change report settings:

Step 1 Load a Report Settings file as described in the “Loading Report Settings” section on page 5-5.

Step 2 Make changes to the report settings as needed.
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Note If you load and make changes to a Report Settings file without saving the file, and you then try 
to choose a new report type or exit Cisco Unified Communications Express Historical Reports, 
the computer displays a dialog box asking if you first want to save the changes that you made to 
the Report Settings file. Click Yes to save the changes in the original Report Settings file or click 
No to continue without saving the changes.

Step 3 Do one of the following actions:

• If you want to save the changes in the Report Settings file that is currently loaded, choose 
File > Save.

• If you want to save the changes in a new Report Settings file, choose File > Save As. Enter the new 
filename in the Save As dialog box, and then click Save.

Report Viewer
The Report Viewer window appears automatically when you click View in the main window of 
Cisco Unified Communications Express Historical Reports to generate a report. The Report Viewer 
window contains the report you have generated. 

Table 5-2 lists the available tools and fields that are found in the Report Viewer toolbar.

To view a report, follow these steps:

Table 5-2 Report Viewer Toolbar: Options

Tool/Field Reference

Close Current View Displaying Group Information Using the Group Tree

Print Report Printing Reports

Export Report Exporting Reports

Toggle Group Tree Displaying Group Information Using the Group Tree

Display Size field Changing the Display Size

Go to First Page Moving Through the Report

Go to Previous Page Moving Through the Report

Page Number field Moving Through the Report

Page Count field Moving Through the Report

Go to Next Page Moving Through the Report

Go to Last Page Moving Through the Report

Stop Loading Moving Through the Report

Search Text Finding and Moving to Specific Text

Help Show online help
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Step 1 In the main window of Cisco Unified Communications Express Historical Reports, choose the report 
settings that you want.

Step 2 Click View.

The report generates and appears in the Report Viewer window.

Some reports can take a few minutes to generate and another few minutes to load into the Report Viewer 
window. To cancel a report while it is generating, click Cancel in the main window or click the Stop 
Loading tool in the Report Viewer window.

For further information on the Report Viewer, see the following sections.

• Changing the Display Size, page 5-7

• Moving Through the Report, page 5-7

• Finding and Moving to Specific Text, page 5-8

• Displaying Information About Groups, page 5-8

• Printing Reports, page 5-10

• Exporting Reports, page 5-10

• Where to Go Next, page 5-11

Changing the Display Size
To change the size of the report display, do one of the following actions:

• From the Display Size drop-down list, choose the size.

• In the Display Size field, enter a value between 25 to 400%.

Moving Through the Report
The Cisco Unified Communications Express Historical Reports client loads pages on demand as you 
move through the report, which is an efficient use of system resources.

The Page Number field in the Report Viewer window shows the number of the currently displayed page. 
The Page Count field (Display only) shows the number of pages in the report. The number of pages in 
the report is not shown until all the pages of a report have been loaded. The number of pages is shown 
as the current page followed by a plus sign (+) to indicate that the report contains additional pages.

Move through a report one page at a time or jump to any specific page. Table 5-3 shows how to move 
through a report.

Note Moving directly to the first page or last page in a long report can take a few minutes. To stop these move 
actions, click the Stop Loading tool in the Report Viewer window.
5-7
Cisco Unified Communications Express Historical Reporting Client Configuration Guide

OL-14986-01



 

Chapter 5      Generating Historical Reports
  Report Viewer
Finding and Moving to Specific Text
To find and move to specific text in a report that appears in the Report Viewer window, perform the 
following steps:

Step 1 On the Report Viewer toolbar, click the Search Text tool.

The Search dialog box appears.

Step 2 In the Find What field, enter the text that you want to find, and then click Find Next.

Caution Wildcard searches are not allowed in this field.

The display moves to the next occurrence of the text that you entered.

You can continue to click Find Next to display subsequent occurrences of the same text.

Step 3 Click Cancel to close the Search dialog box.

Displaying Information About Groups
Most historical reports have a specific set of information that has been designated as a group. For 
example, a group may contain the names of variable or dates. A report displays information arranged in 
group order.

Table 5-4 shows the historical report names and the group to which each report is associated.

Table 5-3 Moving Through Reports: Descriptions

Move Action

Move forward one page Click the Go To Next Page tool.

Move backward one page Click the Go To Previous Page tool.

Move to the last page Click the Go To Last Page tool.

Move to the first page Click the Go To First Page tool.

Move to a specific page Select the number that appears in the Page Number field, enter the 
page number that you want, and then press Enter.

Table 5-4 Historical Reports: Names and Groups

Report Name Group

Abandoned Call Detail Activity Report Call Start Time

Call Custom Variables Report —

Called Number Summary Activity Report Called Number

Application Performance Analysis Report Application ID

Traffic Analysis Report Date
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When you view a report, you can display information for any particular item in its group. For example, 
in the Call Custom Variables Report, you can display information for any single variable.

You display group information using the Group Tree. For many reports, you can also display group 
information directly from the charts that appear with the reports. For further information, see:

• Displaying Group Information Using the Group Tree, page 5-9

• Displaying Group Information from a Report Chart, page 5-9

Displaying Group Information Using the Group Tree

A Group Tree lists the group names available for a report. Most reports have a Group Tree.

To display the group tree for a report:

Step 1 Click the Toggle Group Tree tool on the Report Viewer toolbar. 

The Preview pane appears, displaying a list of groups.

Step 2 To display information for a group in the Preview pane, click the name of the group.

The group information appears in a new pane called a Group Information pane. This pane has a tab that 
shows the name of the group.

If several Group Pane tabs appear, you can display the information that you want by clicking its tab. 

To display the Group Tree when you are viewing information in a Group Information Pane, click the 
Preview tab.

Step 3 To close the Preview pane any time it is displayed, click the Toggle Group Tree tool.

To close a Group Information pane when it is displayed, click the Close Current View tool.

Displaying Group Information from a Report Chart

In many reports, moving the mouse pointer over information displayed in the charts causes the pointer 
to change to a magnifying glass. The magnifying glass indicates that you can display group information 
from that chart.

To display group information from a chart:

Step 1 Make sure that the mouse pointer has changed to a magnifying glass, and then double-click the group 
name or its associated data.

The Group Information pane appears.

Step 2 Do one of the following actions:

– To return to the chart, click the Preview tab.

– To close the Group Information pane, click the Close Current View tool.
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Printing Reports
You can print a report while viewing any part of the report. If you are viewing information in a Group 
Information Pane, only the Information Pane information is printed.

The report is printed on the default printer that has been designated for your computer.

To print a report:

Step 1 In the main window, choose the report settings that you want, and click View.

The report appears in the Report Viewer window.

Step 2 Click the Print tool. 

The Print dialog box appears.

Step 3 In the Print dialog box, choose the settings that you want.

Step 4 Click OK. 

The Printing Records dialog box appears while the file is being printed and shows how the printing is 
progressing.

Exporting Reports
Exporting a report means saving the report in a file. You can specify the name and location of the file 
and the format in which the report is saved. After a report is exported to a file, you can view, print, and 
manipulate the data in the file with another program. 

When you export a report, you can save it in any of the formats shown in Table 5-5.

To export a report:

Step 1 In the main window, choose the report settings that you want, and then click View.

The report appears in the Report Viewer window.

Step 2 Click the Export Report tool.

The Export dialog box appears. 

Table 5-5 Exporting Report:s: Descriptions

Format File Extension Description

Acrobat Format (PDF) .pdf File that can be read with Adobe Acrobat Reader.

Comma-separated 
values (CSV)

.csv Comma-separated text file that can be opened in 
Microsoft Excel or a text editor.

Microsoft Excel (XLS) .xls Microsoft Excel file.

Rich Text Format (RTF) .rtf File that can be opened with Microsoft Word or 
another word processor.

Extensible Markup 
Language (XML)

.xml File that can be opened with a text editor or more 
specialized XML editor.
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Step 3 Click the Format drop-down list, and then choose the format in which you want to save the report.

A series of dialog boxes appear. The specific dialog boxes depend on the format that you chose.

Step 4 Set the desired exporting options and specify the name and location for the export file by enter 
information in the dialog boxes that appear.

When you are finished, the system exports the report and displays the Exporting Records dialog box, 
which shows the progress of the export operation.

To cancel the export operation at any time, click Cancel Exporting.

Where to Go Next
See Chapter 6, “Scheduling Historical Reports.”
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Scheduling Historical Reports

When you schedule a historical report, you are instructing the Cisco UCE Historical Reporting Client to 
automatically generate the report at some time in the future. Although you can schedule a report to 
generate once, the report scheduling function is particularly useful for preparing reports that you require 
regularly. For example, you can schedule an Abandoned Call Detail Activity Report to generate every 
Monday at midnight and a Called Number Summary Activity Report to generate on the first Sunday of 
every month at noon.

The following steps are used to schedule a report:

1. Choose general settings for the report, including the name of the report, whether to include charts, 
and whether to save (export) or print the report.

2. Choose detailed settings for the report, if necessary, including a sort method and a filter parameters.

3. Choose scheduling settings, including how often and when the report is generated.

4. Save the scheduling information.

The following sections include these topics:

• Information in Scheduled Reports, page 6-1

• Scheduling Recommendations, page 6-2

• The Scheduler, page 6-2

• General Settings for Scheduled Reports, page 6-3

• Detailed Settings for Scheduled Reports, page 6-7

• Selecting Schedule Settings, page 6-7

• Saving a Schedule, page 6-9

• Viewing and Deleting Schedules, page 6-9

• Handling Missed Schedules, page 6-11

Information in Scheduled Reports
Table 6-1 shows the types of schedules that you can specify for historical reports and the information 
that is contained in each type of report. 

The time and date for data in scheduled reports is always the time and date of the Cisco UCE server.
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Scheduling Recommendations
When a scheduled report generates, it can use significant resources on the Cisco UCE server. To help 
keep the server running most efficiently, schedule reports to generate at times when the Cisco UCE 
server is least busy, for example, late at night or early in the morning.

The Scheduler
The Cisco UCE Historical Reporting Client includes a program called the Scheduler. The Scheduler 
resides on each client computer and performs the following functions:

• Maintains information about each schedule, including when each schedule should execute and what 
information the scheduled report should contain. The next run time information is based on the 
frequency or recurrence of each job and is stored in the NextRunTime field of the Scheduler 
database.

Table 6-1 Scheduled Historical Reports: Descriptions

Schedule Type Recurrence Options Information Contained in the Report

Daily • Every day (Sunday to Saturday)

• Every weekday (Monday to Friday)

• Every n days (for example, every 3 days)

Note A report that is scheduled to recur every 
weekday runs every Tuesday to 
Saturday so that it can include 
information for Monday to Friday.

A daily report always contains data from 12:00 
midnight (0000) to 11:59:59 p.m. (1159:59) for the day 
before the report runs. For example, a daily report that 
runs on Tuesday contains data for the preceding 
Monday.

Weekly • Every week on a certain day (for example, 
every Monday)

• Every n weeks on a specific day (for 
example, every two weeks on Friday)

A weekly report always contains data from Sunday at 
12:00 midnight (0000) to Saturday at 11:59:59 p.m. 
(1159:59) for the week before the report runs, 
regardless of the day of the week on which the report 
runs. For example, a weekly report that runs on 
Monday, on Wednesday, or on Friday contains data for 
Sunday to Saturday of the previous week.

Monthly • Every month on a specific date (for 
example, the 15th of every month)

• Every month on a certain day (for example, 
the first Friday of every month)

Note If a monthly report is scheduled to run 
on a date that does not occur in some 
months, for example the 30th or 31st, 
the report runs on the last day of a month 
that does not contain the date.

A monthly report always contains data from the first 
day of the previous month at 12:00 midnight (0000) to 
the last day of the previous month at 11:59:59 p.m. 
(1159:59). For example, a monthly report that runs on 
any day in February contains data for all of January.

Once Any single date and time that you specify A report that runs once contains data for the date and 
time range that you specify.
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• Executes schedules at their scheduled times, based on the time and date of the Cisco UCE Historical 
Reporting Client computer and marks their status in the database as Cached so that modification or 
deletion of these schedules cannot occur. New lists of schedules cycle through each hour, ensuring 
that any updates to the Scheduler database by the Cisco UCE Historical Reporting Client are 
available to the Scheduler. 

The Scheduler runs automatically and unattended in the background on the 
Cisco UCE Historical Reporting Client computer. This does not affect other activities that you perform 
on the client computer. The Scheduler should always be left running, even when you exit the Cisco UCE 
Historical Reports main window. If the Scheduler is not running when a schedule should execute, the 
schedule will not execute.

If a schedule does not execute because the Scheduler is not running, the Missed Report dialog box 
appears when the Scheduler restarts. For more information, see the “Handling Missed Schedules” 
section on page 6-11.

You can control the Scheduler using the Scheduler icon. To verify that the Scheduler is running, 
right-click the Scheduler icon and look at the Run Scheduler option in the Scheduler menu. If Run 
Scheduler is dimmed (that is, unavailable), the Scheduler is running.

Note The Scheduler icon does not appear in the Windows status bar under a terminal service session. If you 
need to access features from the Schedule icon, you must do so from the computer on which the 
Scheduler is installed.

Running the Scheduler
To run the Scheduler, follow these steps:

Procedure

Step 1 Right-click the Scheduler icon and choose Run Scheduler. 

Step 2 Or, choose Start > Programs > Cisco UCE Historical Reports > 
Cisco UCE Historical Reports Scheduler.

Step 3 To stop the Scheduler, right-click the Scheduler icon and choose Stop Scheduler. The Scheduler 
remains loaded, but it will not execute schedules.

Step 4 To exit the Scheduler, right-click the Scheduler icon and choose Exit. The scheduler unloads and will 
not execute schedules.

Note If you change the system time on the Cisco UCE Historical Reporting Client computer, stop and then 
restart the Scheduler that is running on that computer.

General Settings for Scheduled Reports
General settings for scheduled reports include the following:

• Name of the report to schedule

• Whether to include charts with the report
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• Whether to print the report or export it to a file

You can return the report settings you choose for a scheduled report to their default values at any time 
by clicking Reset in the Cisco UCE Historical Reports main window.

If you have saved report settings in a Report Settings file, you can load the Report Settings file and use 
it as a basis for a scheduled report. See the “Saving and Loading Report Settings” section on page 5-4 
for information about saving and loading a Report Settings file.

If you have already made settings for a report in this Cisco UCE Historical Reports session, any 
information that you entered in the general or detailed fields for that report appears in those areas when 
you schedule reports. In addition, if the report is set to occur once, date and time information that you 
entered when you set up the report appears in the Cisco UCE Historical Reports Schedule menu. You 
can use the information that appears in the general and detailed fields and in the Schedule menu as a 
basis for your scheduled report, or you can click Reset to return the report settings their default values.

Related Topics

• Choosing the Report to Schedule, page 6-4

• Including Charts with a Scheduled Report, page 6-4

• Choosing Whether to Print or Export a Scheduled Report, page 6-5

Choosing the Report to Schedule
To select the report that you want to schedule, follow these steps:

Procedure

Step 1 In the Cisco UCE Historical Reports main window, click the Schedule Future Reports, Including 
Repeat Reports radio button.

Step 2 Click the General tab, if it is not selected already.

Step 3 Click the Report Type drop-down arrow to view a list of available reports, and then choose the report 
that you want to generate.

Step 4 Choose your schedule settings. Specify whether to include charts with the report, choose whether to print 
or export the report, and choose detailed report settings. Once this step is complete, the schedule will 
execute.

Related Topics

• Including Charts with a Scheduled Report, page 6-4

• Choosing Whether to Print or Export a Scheduled Report, page 6-5

• Detailed Settings for Scheduled Reports, page 6-7

• Selecting Schedule Settings, page 6-7

Including Charts with a Scheduled Report
Each historical report can contain one or more charts that summarize information in the report. If you 
want to include charts with a scheduled report, follow these steps:
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Procedure

Step 1 In the Cisco UCE Historical Reports main window, click the Schedule Future Reports, Including 
Repeat Reports radio button.

Step 2 Click the General tab, if it is not selected already.

Step 3 Check the Include Charts in Report check box.

If you do not want to include charts, uncheck this check box.

You can choose whether to print or export the report, and choose detailed report settings. You also must 
choose schedule settings before the schedule will execute.

Related Topics

• Choosing the Report to Schedule, page 6-4

• Choosing Whether to Print or Export a Scheduled Report, page 6-5

• Detailed Settings for Scheduled Reports, page 6-7

• Selecting Schedule Settings, page 6-7

Choosing Whether to Print or Export a Scheduled Report
When a schedule executes, the Cisco UCE Historical Reporting Client either prints the report or exports 
it (saves it in a file). After choosing this setting, you can choose detailed report settings. You also must 
choose schedule settings before the schedule will execute.

Related Topics

• Printing a Scheduled Report, page 6-5

• Exporting a Scheduled Report, page 6-6

• Detailed Settings for Scheduled Reports, page 6-7

• Selecting Schedule Settings, page 6-7

Printing a Scheduled Report

Scheduled reports print on the default printer that has been designated for your computer. To print a 
scheduled report when it generates, click the Export Type drop-down arrow in the Cisco UCE Historical 
Reports main window and choose Export to Printer.

Now you can choose detailed report settings. You also must choose schedule settings before the schedule 
will execute.

Related Topics

• Exporting a Scheduled Report, page 6-6

• Detailed Settings for Scheduled Reports, page 6-7

• Selecting Schedule Settings, page 6-7
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Exporting a Scheduled Report

The Cisco UCE Historical Reporting Client saves scheduled reports in files. You can view, print, and 
manipulate the data in these files with other programs. Unless you have changed the defaultExportPath 
parameter in the hrcConfig.ini file, the Cisco UCE Historical Reporting client stores these files on the 
client computer in the Cisco UCE Historical Reports\Reports directory, which is under the directory in 
which you installed the Cisco UCE Historical Reporting system. (By default, the system installs in the 
Program Files directory.) 

By default, the client saves scheduled reports in a PDF file. Also by default, the client gives saved reports 
a descriptive filename that indicates the name of the report, its language, its date and time of creation, 
the login identification of the user who scheduled it, its scheduled recurrence, its date range, and the 
format of the file. If desired, you can specify another format, location, and filename. (If you change the 
filename, the client automatically adds descriptive information to the new filename when it creates the 
file.)

When you specify that a generated report is to be saved, you can designate any of the formats shown in 
Table 5-5 in Chapter 5, “Generating Historical Reports.”

To save a scheduled report in a file when the report runs, follow these steps:

Procedure

Step 1 Make sure that Export to File appears in the Export Type field in the Cisco UCE Historical Reports main 
window. If Export to File does not appear, click the Export Type drop-down arrow, and then choose 
Export to File from the list that appears.

Step 2 Change the default format, location, or filename for exported files by clicking Export Location. 

(The Export Location button appears as “...” in the window.)

The Save As dialog box appears. The Cisco UCE Historical Reporting Client adds information to the 
default filename shown in the filename field when the report is generated.

Step 3 Make changes in the Save As dialog box by doing the following:

• To change the location, use the Save In drop-down arrow, the Folder Name pane, or the Save In tools 
to specify the directory in which to save the exported report.

• To change the filename, enter the new name in the File Name field, or click the drop-down arrow 
and then choose it from the list of existing names. If you specify a filename that includes an 
extension shown in Table 5-5 in Chapter 5, “Generating Historical Reports.” The system creates a 
file in that format, regardless of the format that you select in the Save As field.

• To change the format, click the Save As Type drop-down arrow, and then choose the format in which 
you want to save the report.

Step 4 Click Save.

Now you can choose detailed report settings. You also must choose schedule settings before the schedule 
will execute.

Related Topics

• Printing a Scheduled Report, page 6-5

• Detailed Settings for Scheduled Reports, page 6-7

• Selecting Schedule Settings, page 6-7
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Detailed Settings for Scheduled Reports
When you use detailed report settings, you can cause scheduled reports to include only specific 
information or to display information in a particular order. Detailed report settings include a sorting 
method and a filter parameter.

Detailed settings are optional. If you do not choose a detailed setting, the report contains all relevant 
information presented in a default order.

To specify a sorting method and a filter parameter for a scheduled report, follow these steps:

Procedure

Step 1 In the Cisco UCE Historical Reports main window, click the Generate and View Historical Reports 
radio button.

Step 2 Click the Detailed tab.

Step 3 Choose detailed settings just as you do when you generate a report. See the “Detailed Report Settings” 
section on page 5-2 for complete instructions.

After choosing these settings, you must choose schedule settings before the schedule will execute.

Related Topics

• Detailed Report Settings, page 5-2

• Specifying a Sorting Method, page 5-2

• Specifying a Filter Parameter, page 5-3

• Selecting Schedule Settings, page 6-7

Selecting Schedule Settings
After you choose general and detailed settings for a report, you are ready to choose schedule settings. 
You can make changes to any of the report settings later if you want.

When you choose schedule settings, specify:

• How often the schedule executes

• Date and time range of schedule recurrences (if the schedule is to execute more than once)

To choose schedule settings, follow these steps:

Procedure

Step 1 In the Cisco UCE Historical Reports main window, click the Schedule Future Reports, Including 
Repeat Reports radio button.

Step 2 Click the General tab, if it is not selected already.

Step 3 Click Change.

Step 4 In the Occurs area, choose how often the schedule executes, as explained in Table 6-2.
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Step 5 Set Range of Recurrence options as follows:

For a schedule that is set to occur once, choose these settings in the Range of Recurrence area: 

• In the Start Date field, specify the date that you want the schedule to execute.

• In the Start Time field, specify the time that you want the schedule to execute.

For a schedule that is set to occur daily, weekly, or monthly, make these settings in the Range of 
Recurrence area:

• In the Start Date field, specify the first date on or after which you want the schedule to generate.

• In the Start Time field, specify the time at which you want to execute the schedule when the schedule 
occurs.

• Specify how often you want the schedule to recur:

– If you want the schedule to recur indefinitely, click the No end date radio button.

– If you want the schedule to recur a specific number of times, click the End after radio button 
and enter the number of occurrences in the End After field.

– If you want to specify the last date of a range during which you want the schedule to execute, 
click the End by radio button and enter the date in the End By field.

Table 6-2 Scheduling Settings for Historical Reports: Fields

If You Want the Schedule to Execute This 
Often Click Then

Every day Daily Click Every button, and then enter 1 in the Every n Day(s) field.

Every specific number of days (for 
example, every 3 days)

Daily Click Every button, and then enter the number of days in the 
Every n Day(s) field.

Every weekday (Monday to Friday)

Note This report runs every Tuesday to 
Saturday so that it can include 
information for Monday to Friday.

Daily Click Every weekday.

Every week on a certain day (for example, 
every week on Friday)

Weekly Enter 1 in the Every n Week(s) On field, then click the desired 
day.

Every specific number of weeks on a certain 
day (for example, every 2 weeks on 
Monday)

Weekly Enter the number of weeks in the Every n Weeks(s) On field, 
then click the desired day.

Every month on a specific date, (for 
example, the 15th of every month)

Monthly Click the Day n of calendar month. Then enter the date in this 
field, or you can click the drop-down arrow and click the scroll 
arrow to display the date that you want and then click the date. 
(If you enter a date that does not occur in some months, for 
example 30 or 31, the system uses the last day of that month.)

Every month on a certain day (for example, 
the second Friday of every month, or the 
last Sunday of every month)

Monthly Click The number day of calendar month. Click the 
drop-down arrow in the first field and choose the number of the 
day. Then click the drop-down arrow in the second field and 
choose the name of the day.

One time Once In the Report Start Date and Report End Date fields, specify the 
dates and times of the first and last data that you want to include 
in the report.
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Step 6 Click OK to save your schedule settings.

Related Topics

• Information in Scheduled Reports, page 6-1

• General Settings for Scheduled Reports, page 6-3

• Detailed Settings for Scheduled Reports, page 6-7

• Saving a Schedule, page 6-9

Saving a Schedule
After choosing general, detailed, and schedule settings, you are ready to save the scheduling 
information. When you save scheduling information, the system stores the information you have 
specified as a schedule in the Scheduler database.

To save a schedule, follow these steps:

Procedure

Step 1 In the Cisco UCE Historical Reports main window, click Schedule.

The Report Scheduled Successfully dialog box appears.

Step 2 Click OK.

Related Topics

• Information in Scheduled Reports, page 6-1

• General Settings for Scheduled Reports, page 6-3

• Detailed Settings for Scheduled Reports, page 6-7

• Selecting Schedule Settings, page 6-7

• Viewing and Deleting Schedules, page 6-9

Viewing and Deleting Schedules
To see a list of schedules that you created and that are stored in the Scheduler, choose 
Settings > Scheduler from the Cisco UCE Historical Reports main window, or click the Scheduler 
tool. The Scheduled Reports window appears.

To exit the Scheduled Reports window, click Close.

The Scheduled Reports window lists each stored schedule that you created when you were logged into 
the Cisco UCE Historical Reports system using the current login information. This window displays 
each schedule on a row and arranges information about each schedule in the columns shown in Table 6-3.
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To expand a column if you cannot see its entire contents, drag the left or right border next to its title.

Related Topics

• Arranging Order of Display, page 6-10

• Deleting Schedules, page 6-10

Arranging Order of Display
When you open the Scheduled Reports window, the window displays schedules in alphabetical order by 
Report Name. You can change the display order by arranging the schedules in ascending or descending 
order by the information displayed in any column.

To change the order of displayed schedules, click the desired column name. The schedule appears in 
ascending alphabetical or numerical order by the information in that column. Click the same column 
name again to display the information in descending order.

For example, to display the list of schedules in the order that each schedule was created, click the Date 
Created column title. Similarly, to display schedules by recurrence type, click the Recurrence Type 
column title.

Deleting Schedules
When you delete a schedule, the schedule is permanently removed from the Scheduler and will no longer 
be run.

To delete a schedule, follow these steps:

Procedure

Step 1 From the Scheduled Reports window, click anywhere in the row that contains the schedule you want to 
delete.

An arrow appears to the left of the name of the report, indicating that the schedule has been selected.

Step 2 Click Delete.

The Confirmation dialog box appears.

Step 3 Click OK to permanently delete the schedule. 

Table 6-3 Viewing and Deleting Schedules: Descriptions

Column Description

Report Name Name of the scheduled report

Date Created Date and time that the schedule was created

Recurrence Type How often the schedule executes

Export Type Printer, or format of the export file

Apps Server IP address or host name of the Cisco UCE server

Schedule Description Detailed description of the schedule
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If you decide not to delete the schedule, click Cancel instead.

Handling Missed Schedules
In order for a schedule to execute:

• The Cisco UCE server, (or its standby server, if deployed) must be running.

• At least one server on which the Database component is installed must be running.

• The Scheduler must be running on the Cisco UCE Historical Reporting Client computer.

If schedules do not execute because a server is not running, you can generate the reports manually when 
the server is running again.

If schedules do not execute because the Scheduler is not running, the Scheduler identifies missed 
schedules. When the Scheduler restarts, the client computer displays a dialog box that shows the number 
of missed schedules and asks if you want to execute missed schedules. Click Yes to execute missed 
schedules, or click No to continue without executing the schedules. If you click Yes, the reports that 
generate depend on the parameters specified in the Sch.ini configuration file and the scheduling options 
for the reports.

For example, assume that you have set up a schedule to run daily, and that the schedule has no end date. 
In addition, assume that five of these schedules were missed, and that the Sch.ini file instructs the system 
to execute up to three missed daily schedules. When you execute missed schedules, the system generates 
the three most recent daily reports.

As another example, assume that you have set up a schedule to run weekly and to end after four 
occurrences. In addition, assume that all of these schedules were missed, and that the Sch.ini file 
instructs the system to execute up to three missed weekly schedules. When you execute missed 
schedules, the system generates three of the missed weekly reports. The first report will be the one that 
was scheduled to be the final report. The other reports are the two previous reports.

Related Topic

• Configuration File SCH.ini, page 2-6.
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